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Introduction and Roadmap

The following sections describe the contents and audience for this guide— Using the WebLogic
Diagnostic Framework Console Extension:

e “What Is the WebLogic Diagnostic Framework Console Extension?”” on page 1-1
e “Document Scope and Audience” on page 1-2

e “Guide to This Document” on page 1-2

e “Related Documentation” on page 1-2

e “New and Changed Features in this Release” on page 1-3

What Is the WebLogic Diagnostic Framework Console
Extension?

The WebLogic Diagnostic Framework (WLDF) Console Extension is a part of the WebLogic
Diagnostic Framework that provides views and tools for graphically presenting diagnostic data
about servers and applications running on them. The underlying functionality for generating,
retrieving, and persisting diagnostic data is provided by the WLDF framework, and the WLDF
Console Extension provides additional tools for presenting that data in tables, charts, and graphs.

The WLDF Console Extension is implemented as an extension to the BEA WebLogic Server®

Administration Console, using the WebLogic Server Console Extension architecture (see
Extending the Administration Console).
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Introduction and Roadmap

The WLDF Console Extension is included with WebLogic Server 9.2, but you must install it
manually. See Chapter 2, “Installing and Displaying the WLDF Console Extension.”

Document Scope and Audience

This document describes WLDF Console Extension features and installation procedures. It is
written for system administrators or anyone who wants to view graphic representations of
diagnostic data for WebLogic Server instances and applications deployed to them.

It is assumed that readers are familiar with Web technologies and the operating system and
platform where WebLogic Server is installed.

Guide to This Document

This document is organized as follows:

o This chapter, “Introduction and Roadmap,” is an overview of the WLDF Console
Extension and describes the audience for this guide.

e Chapter 2, “Installing and Displaying the WLDF Console Extension,” tells how to install
and display the WLDF Console Extension.

e Chapter 3, “Overview of the WLDF Console Extension,” describes the features and the
user interface of the WLDF Console Extension.

e Chapter 4, “Understanding How Data Is Collected and Presented,” describes how server
and application diagnostic data is collected, maintained, and displayed by the WLDF
Console Extension.

e Chapter 5, “Working with Views,” describes how to create, modify, and use views, which
are panels that contain charts and graphs.

e Chapter 6, “Working with All Charts and Graphs,” describes how to create, modify, and
use charts and graphs, which graphically display the diagnostic data.

e Appendix A, “Keyboard Reference,” describes how to use the keyboard (instead of the
mouse) to accomplish tasks in the WLDF Console Extension.

Related Documentation

o Configuring and Using the WebLogic Diagnostic Framework describes how to configure
and use WLDF.
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New and Changed Features in this Release

e “Configure the WebLogic Diagnostic Framework” in the Administration Console Online
Help describes how to use the WebLogic Administration Console to configure WLDF.

New and Changed Features in this Release

The following features are new to the WLDF Console Extension in this release.

Custom Metrics

You can define custom metrics on an MBean type. Once defined, a custom metric attribute for an
MBean instance can be graphed just like other attributes. See “Creating Custom Metrics” on
page 7-4.

Cut, Copy, and Paste

You can cut, copy, and paste graphs and charts. This gives you more flexibility in how you
organize graphs and charts and allows you to copy and move graphs and charts from one view to
another. See “Arranging Charts and Graphs in Views” on page 6-13 and Appendix A, “Keyboard
Reference.”

Updated Visual and Interaction Design

The WLDF Console Extension has new icons, plus various improvements to the visual tools, such
as additional functionality available in the context menus.

Additional Global Property Settings

On the Global Properties tab, you can now set a default viewport size (the time interval displayed
in a chart) and a default zoom percentage for zooming in or out of a chart (thereby changing the
viewport size). See “Setting Global Properties” on page 6-30.
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CHAPTERa

Installing and Displaying the WLDF
Console Extension

The WebLogic Diagnostic Framework (WLDF) Console Extension is included with BEA

WebLogic Server®, but it is not installed by default. The following section describes how to
install and display the WLDF Console Extension:

e “Installing the WLDF Console Extension” on page 2-1

e “Displaying the WLDF Console Extension” on page 2-3

Installing the WLDF Console Extension

The WLDF Console Extension is delivered as a Java Archive (JAR) file, named
diagnostics-console-extension.jar. You must install this JAR file into the
Administration Server for a domain for the WLDF Console Extension to be incorporated into the
WebLogic Server Console for that domain.

Installation Prerequisites

Before you can install and run the WLDF Console Extension, you need:
o BEA WebLogic Server 9.1 or higher installed

o A Web browser that meets the requirements for running the BEA Weblogic Server 9.1
Administration Console

e JRE 1.5.0 04 (J2SE Runtime Environment 5.0) or above

e Java and JavaScript enabled in your browser
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2-2

Installing the Java Plug-in

If the Java plug-in 1.5 is not already installed in your Web browser, you will be prompted to
initiate a download from the Sun Microsystems Java Web site. Follow the instructions on screen.

Alternatively, install the plug-in manually when you begin the installation process for the WLDF
Console Extension:

1. Go the Java Software download page, at:
http://java.com/en/download/

2. Follow the instructions on screen.

Installing the WLDF Console Extension

To install the WLDF Console Extension:

1. Find the diagnostics-console-extension.jar file in the
WL _HOME\server\lib\console-ext directory, where WL HOME is the directory in which
you installed WebLogic Server.

2. Copy diagnostics-console-extension.jar into the DOMAIN-DIR/console-ext
directory for every domain in which you want to use the Console Extension, where
DOMAIN-DIR is the domain's root directory.

For example, to display diagnostic data for the sample Medrec server that is included with
WebLogic Server, copy diagnostics-console-extension.jar to
DRIVE :\\BEA-HOME\weblogic90\samples\domains\medrec\console-ext.

3. Restart the Administration Server for the domain where you installed the extension. The
Administration Console for the domain is then deployed with the WLDF Console Extension.

Removing the WLDF Console Extension

To remove the extension:
1. Stop the Administration Server.

2. Delete the JAR file from the DOMAIN-DIR/console-ext directory and restart the
Administration Server.
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Displaying the WLDF Console Extension

Displaying the WLDF Console Extension

When you launch an Administration Console in which the WLDF Console Extension is installed,

the Console appears with two tabs, BEA WLS Console and WLDF Console Extension, as
shown in Figure 2-1.

Figure 2-1 Console Extenstion Tah

~
Chon WEBLOGIC SERVER

ADMINISTRATION CONSOLE

BEA WLS Console | WLDF Console Extansion w

||ﬁ.':=|rnrm=r weblogic

By default, the BEA WLS Console tab is initially selected on login, which shows the standard
Administration Console. Select WLDF Console Extension to display the extension.

These two tabs are always present, so you can easily move back and forth between the primary
Administration Console pages and the WLDF Console Extension.

Note: All WLDF Console Extension functionality occurs in the context of a Java applet. Each
time you select the WLDF Console Extension tab, the applet is loaded.

When you select the BEA WLS Console tab, the applet is unloaded, and you are returned
to the Administration Console context that existed before you displayed the WLDF

Console Extension. All activity related to the applet and the WLDF Console Extension
is terminated.

Look and Feel Support

The WLDF Console Extension does not implement a specific look and feel (that is, the visual user
interface design). Rather, it adopts the look and feel of the environment in which the WLS
Administration Console is running:

e For non-Windows systems, the Console Extension uses the look and feel specified in the
Java environment.

e For Windows systems, the Console Extension uses the default Windows look and feel.
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CHAPTERa

Overview of the WLDF Console
Extension

The WLDF Console Extension provides a set of visual tools you can use to directly manipulate
objects to display diagnostic information about WebLogic Server instances. The following
sections provide a high level overview:

“Scope of the Diagnostic Information Displayed”

“Two Main Panels”

“View Panel Overview”

“Tabs Panel Overview”

“Toolbar and Scrollbar Overview”

“Displaying Tooltips for Controls, Views, Graphs, and Charts”
“Creating Views, Graphs, and Charts: Main Steps”

“Alternative Ways to Manipulate Objects”

Scope of the Diagnostic Information Displayed

You install the WLDF Console Extension into a domain, and you can display diagnostic data
about any of the server instances in that domain and about applications running on those servers.
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Overview of the WLDF Console Extension

Two Main Panels

The WLDF Console Extension has two panels, the Tabs panel and the View panel, plus a toolbar
and a status bar, as shown in Figure 3-1.

Figure 3-1 WLDF Console Extension Panels
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View Panel Overview

A view is a collection of one or more charts, which display captured monitoring and diagnostic
data, as shown in Figure 3-2 and Figure 3-3. Views are displayed in the View panel, on the right
side of the WLDF Console Extension page. The View panel displays a single view at a time.

3-2 Using the WebLogic Diagnostic Framework Console Extension



View Panel Overview

Figure 3-2 A View Containing One Chart

Wiew: WMEunbime Yiew

) WMiRurtime@MecRecServer

12:11:44 12:13:24

WlHespsizeCurrent@MedRecserver
DOHespFreeCurrent@Madrecserver

1Z:15:04

Figure 3-3 A View Containing Three Charts
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3-4

Each chart contains a legend, labels, and controls for identifying and displaying the data. A chart
can display data from one or more data sources from one or more servers in the domain. The data
sources include one or more metrics (that is, the value of an MBean instance attribute) or one or
more instrumented methods. Each data source is displayed as a distinct graph, which shows the
values of data points over a time span. The relationship between views, charts, and graphs is
shown in Figure 3-4. In the figure, the view contains two charts, “WLDF Metrics Chart” and
“JVMRuntime@MedRecServer,” based on metrics data from the MedRecServer server. “WLDF
Metrics Chart” contains one metrics graph, “UpTime@MedRecServer.” The
“JVMRuntime@MedRecServer” chart contains two metrics graphs,
HeapSizeCurrent@MedRecServer” and “HeapFreeCurrent@MedRecServer.”

Notes: A chart can include graphs based on data from one or more servers in the domain.
You cannot mix metrics graphs and method performance graphs in the same chart.
Figure 3-4 Relationships of Graphs to Charts and of Charts to Views
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Tahs Panel Overview

The Tabs panel, on the left side of the page, contains tabs with controls for creating and
modifying the views and charts that are displayed in the View panel, on the right.

The Tabs panel contains four tabs:

e Views contains a list of built-in views and custom views. It also contains controls for
creating, modifying, and deleting views. See Chapter 5, “Working with Views.”

e Metrics contains a tree of all known runtime MBean types, instances, and attributes for the
selected server. You can drag attributes onto a view to create one or more graphs that show
the state of those attributes over time. See Chapter 6, “Working with All Charts and
Graphs.”

e Requests contains a tree of events generated by instrumented code in the selected server.
You can drag methods onto a view to create a graph that shows the execution performance
(that is, the elapsed performance time) of those methods over time. See Chapter 6,
“Working with All Charts and Graphs.”

Note: You must configure WLDF instrumentation for a server outside of the WLDF
Console Extension for data to appear in this tab. See “Making Instrumentation Data
Available for Method Performance Charts” on page 8-2.

e Properties contains two subtabs:

— Use the controls in the Properties > Selected Item Properties tab to change the
appearance of individual graphs and charts. See “Setting Chart Properties” on
page 6-23 and “Setting Individual Graph Properties” on page 6-28.

— Use the controls in the Properties > Global Properties tab to set polling and display
properties that apply to all active views. See “Setting Global Properties” on page 6-30.

Toolbar and Scrollbar Overview

The toolbar and scrollbar are available at all times, regardless of which tab is displayed in the
Tabs panel.
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Overview of the WLDF Console Extension

The toolbar is displayed directly above the Tabs and View panels. The buttons and icon in the
toolbar are described in Table 3-1.

Table 3-1 Buttons and Icon in the Toolbar

Button or Icon

Description

Action

Focus context

Click to change focus between the Tabs panel to the View panel.

[_I Save all Click to save all custom views. If no views have been modified since
- modified they were last saved, this button is disabled and is colored gray.
views
[ 1 Discard all Click to discard all changes you made to all views since you last
= unsaved view  saved them.
changes.

Stop all active
views

Click to stop all active views.

Delete

Click to delete selected graph or chart. (This button is unavailable if
a built-in view is selected.

© ¥ @

Status of data
polling

Displays the status of the data poller:

* Green indicates that data is being retrieved from the server with
no problem.

*  Yellow indicates that there are some problems retrieving data
from the server.

* Red indicates that no data is being retrieved from the server.

The status bar at the bottom of the page displays information about the selected item.

Displaying Tooltips for Controls, Views, Graphs, and
Charts

You can display short messages, called tooltips, about several types of objects in the WLDF
Console Extension by positioning the mouse pointer over the objects. To display a tooltip for an
item, move the mouse pointer to point to the object, and pause. Do not click the mouse. After a
momentary delay, a short message about the item is displayed.

3-6
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Creating Views, Graphs, and Charts: Main Steps

In all areas of the WLDF Console Extension, you can display tooltips for standard controls such
as buttons, text fields, sliders, and so forth, which tell you what each control does. But you can
also display details about other objects displayed in the WLDF Console Extension and about the
sources from which the diagnostic data is gathered, as described in the following sections:

e “Displaying Details About MBean Instances and Attributes in the Metrics Tab” on
page 7-3

e “Displaying Details About Metrics Charts and Graphs” on page 7-3

e “Displaying Details About Requests” on page 8-4

e “Displaying Details About Instrumentation Events” on page 8-5

e “Displaying Details about Requests and Methods in the Requests Tab” on page 8-7

e “Displaying Details About Method Performance Charts” on page 8-8

Creating Views, Graphs, and Charts: Main Steps

To create a view and add charts and graphs:

1. From the Views tab, create or select a view. See Chapter 5, “Working with Views.”

2. Decide which kind of chart you want to create and select the appropriate tab for creating that
kind of chart:

— Use the Metrics tab to create a metrics chart, or
— Use the Requests tab to create a method performance chart.

See Chapter 6, “Working with All Charts and Graphs.”

3. Inthe Metrics tab or Requests tab, select the server for which you want to display diagnostic
data. See Chapter 6, “Working with All Charts and Graphs.”

4. Drag items from the Metrics or Requests tab in the left panel to the active view in the right
panel. Drop an item into a blank area in the view to create a new chart and graph, or drop it
into an existing chart to add a new graph to the other graph(s) in the chart. See Chapter 6,
“Working with All Charts and Graphs.”

5. Optionally, select the Properties tab, and use the tools on that tab to change the appearance
of graph(s) and chart(s). See Chapter 6, “Working with All Charts and Graphs.”

6. If are working with a custom view, save the view. See Chapter 5, “Working with Views.”
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Alternative Ways to Manipulate Objects

The WLDF Console Extension is a graphical user interface with visual tools for setting attributes
and manipulating objects. Alternative interaction techniques are available for accomplishing
many activities:

e Drag and drop and other direct manipulation with the mouse. For example, you can
drag an MBean instance attribute from the Tabs panel to the View panel to create a new
chart. Another direct manipulation technique is to Shift-drag across a graph in a chart to
zoom in on the data.

o Right-click, then select from a context menu. You can right-click attributes in the
Metrics tab, methods in the Requests tab, and charts in the View panel to display context
menus, from which you can select a command to act on the selected object. For example,
you can right-click an MBean instance attribute in the Tabs panel, then choose Create
New Chart to incorporate it into a new chart.

e Keyboard interaction. You can use the Tab key, the arrow keys, and the Enter key to
select different tools and objects on the page and then perform actions on them. For full
documentation, see Appendix A, “Keyboard Reference.”
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CHAPTERa

Understanding How Data Is Collected
and Presented

The following sections describe the relationship between and the process of data collection and
presentation in the WLDF Console Extension:

e “Overview of Data Collection and Presentation”
e “How Metrics Data Is Collected and Presented”

o “How Instrumentation Data Is Collected and Presented”

Overview of Data Collection and Presentation

In a standard WLDF configuration, you can configure the Harvester to collect metrics for
specified attributes of specified MBean instances. This information is available for programmatic
access, and it is written to a standard log, HarvestedDataArchive, which you can view through
the standard Administration Console. See “Configuring the Harvester for Metric Collection” in
Configuring and Using the WebLogic Diagnostic Framework.

In the Instrumentation component, you can configure diagnostic actions to generate
instrumentation events when the diagnostic actions are executed. See “Configuring
Instrumentation” in Configuring and Using the WebLogic Diagnostic Framework. This
information, too, is persisted in a standard log, EventsDataArchive., which you can view
through the standard Administration Console.

Those WLDF components and log files enable you to display data in the WLDF Console
Extension:
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e To view current metrics data in the WLDF Console Extension, it is not necessary to
configure the Harvester. Data is retrieved from a data cache on the server. However, to see
historical metric data, you must configure the Harvester to collect the data you want to
monitor. Historical data is always retrieved from the HarvestedDataArchive log. See
“How Metrics Data Is Collected and Presented” on page 4-2.

e To view current and historical data for instrumented methods, you must configure
Instrumentation as part of the WLDF configuration for the server. Instrumentation data
displayed in the WLDF Console Extension is always retrieved from the
EventsDataArchive log. See “How Instrumentation Data Is Collected and Presented” on
page 4-5.

Data displayed in the WLDF Console Extension is generated, collected, and optionally persisted
on the server, and the WLDF Console Extension on the client periodically polls that data for
display in a chart.

How Metrics Data Is Collected and Presented

42

When a view containing one or more metrics charts is activated in the WLDF Console Extension,
data collection for viewing those metrics in real time is started on the server. The data collector
continually gathers the data and places it in a “wrap-around” cache. That is, as new data fills the
cache, the oldest data in the cache is lost. When a view is stopped (see “Starting and Stopping a
View” on page 5-6), data collection for the contained charts is stopped. However, if the Harvester
is configured to collect data for a metric, that data will continue to be harvested and persisted to
the log.

To display current data, the WLDF Console Extension periodically polls the cache for a current
data set and displays it in a chart.

Note: The size of the data set returned to the client is configurable. See “Setting Global
Properties.”

To display current metric data, no prior WLDF configuration is required. However, to display
historical data for a metric, the WLDF Harvester must have been configured to harvest that data.

The following four illustrations (Figure 4-1, Figure 4-2, Figure 4-3, and Figure 4-4) show how
metric data is retrieved and displayed for present and historical data, with and without harvesting.

These conceptual illustrations show a timeline from server startup to the present:

1. The tail of the arrow, on the left, represents the time when the server was started. The tip of
the arrow, on the right, represents the present.
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The point in the middle of the arrow represents the time when a view containing the metrics
chart was activated and, therefore, when the Console Extension client started polling for data
to display for that metric.

The oval represents the range of data that is being displayed in a chart in the Console
Extension, sometimes called the viewport.

The data cache always contains the most current data. But if polling has been taking place
long enough for old data to be purged, the cache does not contain all data from the time
polling started. That is why the range of data shown through the viewport is not equivalent
to the range of data collected since polling began.

If the Harvester was not configured to harvest data for this metric, no historical data is
available for the metric and therefore cannot be displayed in the WLDF Console Extension
client. If the Harvester was configured to harvest data for this metric, historical data is
available for the metric and can be displayed by scrolling back through a chart (see
“Scrolling and Zooming the Data Displayed in a Chart.”

Figure 4-1 illustrates the following scenario:

1.

2.

When the server starts, the Harvester is not configured for the metric. Therefore, no data is
saved for later retrieval.

At some point after the server is started, the Console Extension is started and the view
containing the metrics chart is activated. Polling for the metric begins, and the current data
fills the cache.

The metrics chart shows current data from the cache. If you tried to scroll to see historical
data, you could not see any, since none is available.

Figure 4-1 No Harvesting; Display Current Data

1. Server started 2. Polling started
(Harvester not configured
for this metric)

Historical data in archive Current data in cache

i >

3. Current data displayed
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Figure 4-2 illustrates the following scenario:

1. When the server starts, the Harvester is configured for the metric and starts to harvest data
when the server is started. The data is persisted to the archive, and it can be retrieved for
viewing.

2. At some point after the server was started, the Console Extension is started and the view
containing the metrics chart is activated. Polling for the metric begins, and the current data
fills the cache.

3. The metrics chart, displayed in the client, shows current data from the cache. Because the data
was harvested and archived, you can scroll the chart to see historical data. However, in this
illustration, the chart is still set to display current data. Even though data for the metric is
being saved in the archive, the current data is still retrieved from the cache.

Figure 4-2 Harvesting; Display Current Data

1. Server started and Harvester 2. Polling started
configured for this metric

Historical data in archive Current data in cache
- 5
._ >

3. Current data displayed

The scenario in Figure 4-3 shows the same scenario as in Figure 4-2, but in this case, the chart is
scrolled to show historical data. All data is retrieved from the archive. Current data continues to
fill the cache, but that data is not currently used.
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Figure 4-3 Harvesting; Display Historical Data

1. Server started and Harvester 2, Polling started
configured for this metric
Historical data in archive Current data in cache
I j »
h &

3. Historical data displayed

The scenario in Figure 4-4 shows the same scenario as in Figure 4-2 and Figure 4-3, but in this
case, the chart is scrolled to show some historical data and some current data. The historical data
is retrieved from the archive, and the current data is taken from the cache.

Figure 4-4 Harvesting; Display Current and Historical Data

1. Server started and Harvester 2. Polling started
configured for this metric

Historical data in archive Current data in cache

i' : >

/

3. Historical and current data displayed

How Instrumentation Data Is Collected and Presented

For instrumentation data to be displayed in a chart, instrumentation must be configured in the
WLDF configuration on the server. Data is always retrieved from the persisted store. If
instrumentation is not configured and activated for a server, you will not be able to see any events
in the Requests tab. For more about these requirements, see “Making Instrumentation Data
Available for Method Performance Charts” on page 8-2.
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A view is a named collection of charts and graphs that present graphical information of similar
diagnostic type data. The following sections describe how to work with views:

“The Views Tab and the View Panel”

“Displaying and Modifying an Existing View”
“Creating a Custom View”

“Creating a View Based on an Existing View (Cloning)”
“Changing the Name of a View”

“Saving A Custom View”

“Deleting a View”

“Starting and Stopping a View”

The Views Tab and the View Panel

The Views tab in the Tabs panel, on the left side of the page, contains a list views for all running
servers in the domain. It also provides the means to create, select, modify, and delete views. When
you select (click) the name of a view in the Views tab on the left, the view is displayed in the
View panel on the right, as shown in Figure 5-1. That view remains displayed in the View panel,
even when you select different tabs in the Tabs panel.
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Figure 5-1 Views Tab and View Panel

~— The view selected in the View tab...

...is displayed in the View panel

A
r h]
Bd e ® X
views | (27 Metrics | 14 Resquests | Praperties | Wiew: Server WiorkManagerRurtimes@MedRecServer
- crege | Cone | Unceleteview
| Buitin Views
[&] IDBCDataSourceRirtinds@Medhecierver
IMSServerfuntimesPMddRecServer
Application WorkManagefRunt mesTMediecsarver
~.] IMunbme iew
JitELnbine iew 09:39:08 942129 08:35:09 942129
- . sQMediecserver
| ServerChannel AcceptCount View@MedRecServer ®Fendnghiequest ® PendrgRequeste@iedFiecServer
] Servarchianrel Bytec Recetved{Surk slewGHeRacSHrver *Co-duht:d:mmm ‘CmMamtmsetw
.| SarverChannel Cornections View@MadRecsarver e S e B T
| ServerThannel Messages Recetved{Serk Yiew@MedRacServer ;
5] ThreadPooRurkime ew - webicgic kernel Ken-Blocking £ ImageWorkianager
) Custom Views 1 1
Cugtom ew #1
Instrumentation
09:39:09 09:42:29 it 09:42:29
®FendrghaquestsEMechecierver ® Fendrgfaquests@Medhecierver
CompletedfequestsifechecServer Completedflequests@MedhecServer
e StuckTheeadCourhBMedRecServer e StuckTheeadCounbBMedRecserver
137 weblogic. jms MedRacSAFAgent@MadRecSarver Limited 1 weblogic.sof sgant, MedRac SAFAQant Serder
I’ ]I
[ ey s aaz 7 &l
Selected Canned ‘i Server |

The Views tab lists both built-in and custom views.

o The Built-in views are a set of predefined views of available runtime metrics for all running
WebLogic Server instances in the domain. These views surface some of the more critical
runtime WebLogic Server performance metrics and serve as examples of the WLDF
Console Extension’s view and graphing capabilities.

Built-in views are installed when you install the WLDF Console Extension, and they are
available for every user logged into the Administration Console and using the WLDF
Console Extension.

You can modify a built-in view, but the modification is only visible during your current
session; it is lost when you switch back to the primary Administration Console view. Also,
no other user can access the modified view. If you want to modify and save one of the
built-in views, you can clone it and save it as a custom view.
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e A custom view is any view created by a user. Custom views are available only to the user
who created them. You can save a custom view and access it again when needed.

WLDF Console Extension provides no pre-defined custom views.

The charts and graphs in a view can display diagnostic data for any of the servers running in the
domain.

The views listed in the Views tab are displayed in separate trees, as shown in Figure 5-2.

Figure 5-2 Built-in and Custom Views Displayed in the View Tab
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Table 5-1 describes the visual cues that help identify the views in the Views tab.

Table 5-1 Views Tab Icons

Visual Cue Description Description
i =] ThreadPaolRuntime View Blue and white icon ~ The view is active and data polling is
adjacent to a view occurring for all charts in that view. (This
name is true whether or not the view is currently

displayed in the View panel.)
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Tahle 5-1 Views Tab Icons

Visual Cue Description Description

- IDBCRURLime wiew

Gray and white icon  The view is inactive and data polling is not
adjacent to a view  occurring for the charts in that view.

name

------ [2] FerverkuntimeMBean view

View name in italic =~ The view has been modified but not yet
font saved.

Note: You cannot save changes to a
built-in view.

Displaying and Modifying an Existing View

To display and modify an existing view:

1.
2.

Select the Views tab to display the list of available views.

Click the name of the view. The view appears in the View panel, replacing the view that is
currently displayed. (Only one view can be displayed at a time.)

Add and modify charts, as desired. See Chapter 6, “Working with All Charts and Graphs.”

Save the view (custom views only):

— In the Views tab, click the Save button, or

— On the toolbar, click the [—I (Save All Modified Views) button.

Creating a Custom View

To create and display a new custom view:

1.
2.

5-4

Click the Views tab.

In the text field at the bottom of the browser, enter a name for the view.

Click Create to create the view. The new, empty view is displayed in the View panel.
Add and modify charts, as desired. See Chapter 6, “Working with All Charts and Graphs.”

Save the view:
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— In the Views tab, click the Save button, or

— On the toolbar, click the =l (Save All Modified Views) button.

Creating a View Based on an Existing View (Cloning)

To create and display a view based on an existing view:

1. Select the Views tab.

2. Click the name of the existing view on which you want to base a new view.
3. In the text field at the bottom of the browser, enter a name for the new view.

4. Click Clone, at the bottom of the Views tab, to copy the current view with a new name. The
new, cloned view is displayed in the View panel. Until you make changes, the cloned view
has the same properties as the view upon which it is based.

5. Add and modify charts, as desired. See Chapter 6, “Working with All Charts and Graphs.”

6. Save the view:

— In the Views tab, click the Save button, or

— On the toolbar, click the (= (Save All Modified Views) button.

Changing the Name of a View
You can change the names of custom views only. To change the name of a view:
1. Select the Views tab.

2. Right-click the name of the view you want to rename, select Rename, and type a new name.
Alternatively, in the View panel, right-click the name of the current view at the top of the
panel. Then type a new name in the field.

3. In the Views tab, click the Save button.

Saving A Custom View

While you can modify any view for the current session, you can save only custom views. To save
a custom view:
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1. Select the Views tab.
2. Click the name of the custom view you want to save.

3. Click the Save button.

Alternatively, click the [—I (Save All Modified Views) button on the toolbar.

Deleting a View

You can only delete custom views. To delete a custom view:
1. Select the Views tab.
2. Click the name of the view you want to delete.

3. Click the % (Delete) button in the toolbar. Alternatively, right-click the name of the view
and select Delete from the context menu.

Starting and Stopping a View

5-6

When you start a view, polling commences for the charts in the view. That is, the client starts
polling for data from the server, so that the data can be represented in one or more graphs. When
you stop a view, polling for the view ends.

To start a view:
1. Select the Views tab.
2. Right-click the view you want to start, and select Start from the context menu.

To stop a view:

1. Click the Views tab.

2. Right-click the view you want to stop, and select Stop from the context menu.

To stop all views, click the @ (Stop All Active Views) button on the toolbar to stop all active
views.

Note: Current data for metrics charts is polled from a data cache on the server. Historical data
for metrics charts and all data for method performance charts are retrieved from data
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archives. If you stop all views, data is no longer added to the data cache on the server.
For more information, see Chapter 4, “Understanding How Data Is Collected and
Presented.”
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Working with All Charts and Graphs

CHAPTERa

The WLDF Console Extension supports two types of charts and graphs:

e Metrics charts contain one or more graphs that real-time and harvested MBean metric

information.

e Method performance charts contain one or more graphs displaying elapsed time

information for a given instrumented method.

Both kinds of charts can display information from one or more running server instances in the
domain.

Many of the tasks you perform when working with charts are the same for both types. Some tasks
are different for the different types. The following sections describe how to work with both kinds
of charts:

“The Parts of a Chart” on page 6-2

“Adding Charts to Views” on page 6-4

“Creating an Empty Chart” on page 6-8

“Adding Graphs to Existing Charts” on page 6-8

“Repositioning a Chart” on page 6-11

“Merging Charts” on page 6-12

“Moving a Graph to a Different Chart or to a New Chart” on page 6-12

“Arranging Charts and Graphs in Views” on page 6-13
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e “Starting and Stopping Data Collection for Charts in a View” on page 6-18
e “Scrolling and Zooming the Data Displayed in a Chart” on page 6-19
e “Deleting a Graph from a Chart” on page 6-22

e “Deleting a Chart” on page 6-23

e “Setting Chart Properties” on page 6-23

e “Changing a Chart Name” on page 6-24

e “Creating a Y-Axis Label for a Chart” on page 6-25

e “Setting a Chart Graphing Style” on page 6-25

e “Turning a Chart Legend On and Off” on page 6-26

e “Turning a Chart Scrollbar On and Off” on page 6-27

e “Changing Chart Foreground and Background Colors” on page 6-27
e “Changing Chart Foreground and Background Colors” on page 6-27
e “Setting Individual Graph Properties” on page 6-28

e “Changing a Graph Name” on page 6-29

e “Changing a Graph Scaling Factor” on page 6-29

e “Changing a Graph’s Colors” on page 6-29

e “Setting Global Properties” on page 6-30

For information about tasks that are specific to the different kinds of charts and graphs, see the
following:

e Chapter 7, “Working with Metrics Charts and Graphs.”
e Chapter 8, “Working with Method Performance Charts and Graphs.”

The Parts of a Chart

A chart consists of the following:
e One or more graphs that show data points over a specified time span

e X- and Y-axes for plotting diagnostic data
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— Plots against a time-based X-axis.

— Provides a scaled Y-axis, (adjusted based upon the plotted data series.)

o A legend that identifies the scope of each of the graphs in the chart:

— The legend for a metrics chart uses the scope of the form
attributeName@serverName

— The legend for a method performance chart uses the scope of the form

methodName@serverName
The legend can be hidden or displayed.

e A scrollbar for changing the time span displayed on the chart’s X-axis. The scrollbar can
be hidden or displayed.

e Optional Y-axis label

These parts are shown in Figure 6-1.

Figure 6-1 Parts of a Chart
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Several graph styles are available for presenting data: area, area radar, bar, plot, scatter plot,
stacking area, and stacking bar. For instructions on how to set those styles, see “Setting a Chart

Graphing Style” on page 6-25.
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Adding Charts to Views

You create and add charts to views by dragging items from the Metrics tab or the Requests tab,
as described in the following steps.

1. Select the Views tab and select the view to which you want to add a chart (or create a new
view). Figure 6-2 shows an empty view.

Figure 6-2 Empty View
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2. Select the Metrics tab to create a chart based on metrics, or select the Requests tab to create
a chart based on events generated by instrumented methods.

3. Drag a valid item from the tree to the view. The cursor changes shape, and the background
darkens when you drag it into an area where you can insert a chart, as shown in Figure 6-3.
For information about what items can be dragged from the Metrics tab, see Chapter 7,
“Working with Metrics Charts and Graphs.” For information about what items can be dragged
from the Requests tab, see “Working with Method Performance Charts and Graphs™ on
page 8-1.
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Figure 6-3 Dragging a Metric to Create a New Chart in an Empty View
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When you release the mouse button, a chart is created that contains a graph based on the

item you dragged from the tree in the left panel, as shown in Figure 6-4.
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Figure 6-4 A Chartin a View
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Note: An alternative to dragging an item into a chart is as follows:

e Right-click the item in left panel (the Metrics tab or the Request tab). The Add to
Chart menu is displayed.

e Right-click an item in the Metrics tab or in the Requests tab and select Create
New Chart to create a new chart containing a graph based on the selected item

e Right-click an item in the Metrics tab or in the Requests tab and select Add to
Chart, then the name of an existing chart, to add a graph to the named chart.

4. To add another chart to the view, drag another item from the tree to a position above, below,
or to the side of an existing chart. Figure 6-5 shows an item dragged to the right of a chart.
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Figure 6-5 Dragging a Metric Into an Existing View to Create a Second Chart
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The new chart appears where it was dropped, as shown in Figure 6-6. All charts in the
view are resized to fit together.
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Figure 6-6 Two Charts in a View
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For alternative ways to arrange charts and graphs, see “Arranging Charts and Graphs in Views”
on page 6-13.

Creating an Empty Chart

To create an empty chart:
1. Right-click anywhere in a view.

2. Select New Chart. You can now add one or more graphs to the chart, as explained in “Adding
Graphs to Existing Charts” on page 6-8.

Adding Graphs to Existing Charts

To graph data from more than one data source on the same chart (that is to add a graph to an
existing chart), drag the appropriate item from the Metrics tab or the Requests tab to the existing
graph in the View panel, as described in the following steps:

1. Select the Views tab to display the list of views.

6-8 Using the WebLogic Diagnostic Framework Console Extension



Adding Graphs to Existing Charts

2. Click the view containing the chart to which you want to add another graph (data source).
Figure 6-7 shows a chart with one graph.

Figure 6-7 Chart with One Graph
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3. Select the Metrics tab to add a graph based on metrics, or click the Requests tab to add a
graph based on instrumentation events.

All graphs in a chart must be based on the same type of diagnostic data. That is, you

Note:
cannot add metrics data to a method performance chart or instrumentation data to a

metrics chart.

Drag a valid item from the tree to the view, as shown in Figure 6-3. For information about
what items can be dragged from the Metrics tab, see Chapter 7, “Working with Metrics
Charts and Graphs.”. For information about what items can be dragged from the Requests
tab, see “Working with Method Performance Charts and Graphs” on page 8-1.
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Figure 6-8 Dragging a New Diagnostic Data Source to an Existing Chart
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The new graph is added to the chart, as shown in Figure 6-9.
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Figure 6-9 Resulting Graph with Two Charts

~— Metric chart of HeapFreeiMedRedServer

~— Metric chart of UpTime@MedRedServer
=1 R @
| v 5 Metrce | g Raguunsts | Properties | Ve Custom Yiew #1
| server [Meciecsarer <] Redoad
A.gly'ﬁlrawtb-ﬁ:emmﬁulme | ) WLDF Metrics Chart
170,000,000
'!“'»...‘
Il o
150,000,000 | \-._
L
120,000,000 | \-._.
P - | s
210,000,000 .\‘l‘ Jl f
‘._. '\\
5 I LN
50,000,000 ) -
“\\_ I o ||
e . |
0,000,000 . | |
\
.
St )
50,000,000 N 1[
30,000,
15:55:55 15:57:35 15:59:15 16:00:55
@ s FresCurni@HsdRecsn
HaFresParientBHeRacre
Sebestar Chart WLDF Matrics Chirt

For alternative ways to arrange charts and graphs, see “Arranging Charts and Graphs in Views”

on page 6-13.

Repositioning a Chart

To reposition a chart in a view:
1. Select the Views tab and select the view containing the chart you want to reposition.

2. Drag the chart to the new position in the view. That is, click the chart and hold the mouse
button down while you drag. You position the chart above, below, to the left, or to the right of
an existing chart. When the chart is in an acceptable position, a band of the background is
darkened. This behavior is the same as when creating a new chart, as illustrated in Figure 6-5.

3. Release the mouse button.
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For alternative ways to arrange charts and graphs, see “Arranging Charts and Graphs in Views”
on page 6-13.

Merging Charts

When you merge charts, all the graphs and associated legend entries of the source chart are added
to the graphs and the legend of the target chart. Properties of the target chart--such as the title,
colors, and the Y-axis label--are maintained, and any conflicting properties from the source chart
are lost. Once successfully merged, the source chart is deleted.

You can merge one or more charts in the same view or in different views.

To merge one chart with another in the same view:
1. Select the Views tab and select the view containing the charts you want to merge.

2. Drag the source chart onto the target chart. That is, click the chart and hold the mouse button
down while you drag. When the source chart is positioned correctly over the target chart, the
background of the target chart is darkened.

3. Release the mouse button.

All the graphs and associated legend entries of the source chart are added to the graphs and
the legend of the target chart. Properties of the target chart--such as the title, colors, and
the Y-axis label--are maintained, and any conflicting properties from the source chart are
lost. Once successfully merged, the source chart is deleted.

For alternative ways to arrange charts and graphs, see “Arranging Charts and Graphs in Views”
on page 6-13.

Moving a Graph to a Different Chart or to a New Chart

6-12

You can move a graph to a different chart only if the target chart does not already contain a graph
based on the same data source.

To move a graph from one chart to another:

1. Select the Views tab and select the view containing the graph you want to move. The source
chart and the target chart must be in the same view.

2. Shift-click the graph (or its legend entry) to select it. Release the Shift key and the mouse
button, and do not click or select anything else until you perform the instructions in the
following step.

Using the WebLogic Diagnostic Framework Console Extension



3.

Arranging Charts and Graphs in Views

Drag the graph from the source chart to the target chart or to an empty area in the view. That
is, click the already selected graph and hold the mouse button down while you drag. When
the graph is positioned correctly over the target chart (or over the empty area), the background
of the target chart (or the empty area) is darkened.

Release the mouse button. The graph and its legend are added to the target chart and removed
from the source chart. If you dragged to an empty area, a new chart containing the graph is
created.

For alternative ways to arrange charts and graphs, see “Arranging Charts and Graphs in Views”
on page 6-13.

Arranging Charts and Graphs in Views

Table 6-1 shows how to copy, move, and duplicate charts and graphs by dragging and dropping
with the mouse, by using context menus with the mouse, and by using the keyboard. For brevity,
some common information is not repeated for each item in the table. That information is as
follows:

When you move a chart or graph, the original is deleted (that is, it is removed from its
original position).

When you copy or duplicate a chart or graph, the original remains unchanged.
When you merge a chart, the original chart is deleted.

Drag and drop means to click an item with the mouse, move it to a new location without
releasing the mouse button, then releasing the mouse button to place the item in the new
location.

To copy a graph or chart by dragging and dropping, start dragging the item, press the Ctrl
key before releasing the mouse button, then drop the item (release the button) in the
selected position.

When you right-click in the View panel, a context menu is displayed. The menu contains
commands that are appropriate for the current context. Context menus in the View panel
contain several commands for arranging charts and graphs.

To select a chart using the mouse, click the chart in the View panel. To select a graph in a
chart, Shift-click the graph, or Shift-click the name of the graph in the chart legend. You
can then right-click the selected graph (or graph name) to display a context menu.
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e To select a chart in the View panel using the keyboard, press Tab or Shift+Tab to cycle
through the items, that is, to select one item after the other. See also Appendix A,
“Keyboard Reference.”

e When you select Paste chart to new chart from a context menu or press Ctrl+Shift+V
from the keyboard, the most recently cut or copied item is inserted at the top of the current
view. If the item is a graph, a new chart containing that graph is created.

e You can drag and drop a graph or chart to place it in a specific location above, below, or to
the left or right of an existing chart. To do this, you drag the item to a border area, which is
highlighted when it is selected. However, you cannot select a border area using context
menus or the keyboard. Therefore you cannot use those methods to select a specific
location to insert a chart. However, you can select Paste chart to new chart from a
context menu or press Ctrl+Shift+V from the keyboard to insert an item at the top of the
current view

e To use the keyboard to select a different view:
a. Press Ctrl+%— to select the Tabs panel.
b. Press Tab repeatedly until the current tab title is selected.

c. Ifthe current tab is not the Views tab, press =* or 4= repeatedly until the Views tab is
selected.

d. Press Tab to enter the Views tab.

e. Press 1 or ¥ repeatedly until the desired view is selected.
f. Press Enter.

g. Press Ctrl+ —* to select the View panel again.

6-14 Using the WebLogic Diagnostic Framework Console Extension



Table 6-1 Arranging Charts and Graphs

Arranging Charts and Graphs in Views

Action

Using Drag and Drop

Using Context Menus

Using the Keyboard

Move a chart to a
different position in

1. Drag the chart to the
new position.

Right-click the chart.

—_

Select the chart.

) 2. Select Move Chart,then 2. Press Ctrl+X.
the same view 2. Drop the chart. selecta position fromthe 3 press Crl+Shift-+V.
submenus.
Move a chart to a Not available 1. Right-click the chart. 1. Select chart.
different view 2. Select Cut Chart. 2. Press Ctrl+X.
3. Select the target view. 3. Select the target view.
4. Right-click anywhere in 4. Press Ctrl-Shift-V.
the view.
5. Select Paste chart to
new chart.
Copy a chartto a Not available 1. Right-click the chart. 1. Select the chart.
different view 2. Select Copy Chart. 2. Press CtrI+C.
3. Select the target view. 3. Select the target view.
4. Right-click in view. 4. Press Ctrl+Shift+V.
5. Select Paste chart to
new chart.
Duplicateachartin 1. Drag the chart to the 1. Right-click the chart. 1. Select the chart.
the same view new position 2. Select Copy Chart. 2. Press CtrI+C.
2. Press Ctrl while 3. Right-click anywhere in 3. Press Ctrl+Shift+V.
dragging. the view.
3. Drop the chart. 4. Select Paste chart to
new chart.
Merge a chart with 1. Drag the source chart 1. Right-click the source 1. Select the source chart.
another chart in the to the target chart. chart. 2 Press Ctrl+X.
same view 2. Drop the chart. 2. Select Cut Chart. 3. Select the target chart.
Right-click the target 4. Press Ctrl+V.
chart.
4. Select Paste chart.
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Table 6-1 Arranging Charts and Graphs

Action

Using Drag and Drop

Using Context Menus

Using the Keyhoard

Merge a copy of a
chart with another
chart in the same
view

1. Drag the source chart
to the target chart

2. Press Ctrl while
dragging.
3. Drop the chart.

1. Right-click the source
chart.

2. Select Copy chart.

Right-click the target
chart.

4. Select Paste chart.

1. Select the source chart.
2. Press Ctrl+C.
3. Select the target chart.
4. Press Ctrl+V.

Merge a chart with  Not available 1. Right-click the source 1. Select the source chart.
achartin a different chart. 2. Press Ctrl+X.
view 2. Select Cut chart. 3. Select the other view.
Select the other view. 4. Select the target chart.
Right-click the target 5. Press Ctrl+V.
chart.
5. Select Paste chart.
Merge a copy of a  Not available 1. Right-click the source 1. Select the source chart.
chart with a chart in chart. 2. Press Ctrl+C.
a different view Select Copy Chart. 3. Select the other view.
Select another view. 4. Select the target chart.
Right-click the target 5. Press Ctrl+V.
chart.
5. Select Paste chart.
Move agraphtoa 1. Drag the graph to the Shift-click the graph. 1. Select the source graph.
different chart in target chart. 2. Right-click the selected ~ 2. Press Ctrl+X.
the same view 2. Drop the graph. graph. 3. Select the target chart.
Select Cut graph. 4. Press Ctrl+V.

Right-click the target
chart.

5. Select Paste graph.
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Table 6-1 Arranging Charts and Graphs

Arranging Charts and Graphs in Views

Action Using Drag and Drop Using Context Menus Using the Keyhoard

Copy a graph to 1. Drag the graph to the 1. Shift-click the graph. 1. Select the source graph.

another. chart in the target chart. 2. Right-click the selected 2. Press Ctrl+C.

same view 2. Press Ctrl while graph. 3. Select the target chart.
dragging. 3. Select Copy graph. 4. Press Ctrl+V.

3. Drop the graph.

4. Right-click the target
chart.

5. Select Paste graph.

Move a graphtoa  Not available 1. Shift-click the graph. 1. Select the source graph.
chart in a different 2. Right-click the selected ~ 2. Press Ctrl+X.
view graph. 3. Select the other view.
3. Select Cut graph. 4. Select the target chart.
4. Select the other view. 5. Press Ctrl+V.
Right-click the target
chart.
6. Select Paste graph.
Copy agraphtoa  Not available Shift-click the graph. 1. Select the source graph.
chart in a different 2. Right-click the selected 2. Press Ctrl+C.
View graph. 3. Select the target chart.
3. Select Copy graph. 4. Press Ctrl+V.

4. Select the other view.

5. Right-click the target
chart.

6. Select Paste graph.

Copy a graph to
create a new chart
in the same view

1. Drag the graph to a
border in the view.

2. Press Ctrl while
dragging.
3. Drop the graph.

Shift-click the graph.

2. Right-click the selected
graph.
Select Copy graph.

4. Right-click anywhere in
the view.

5. Select Paste chart to
new chart.

. Select the source graph.
2. Press Ctrl+C.
Press Ctrl+Shift+V.
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Table 6-1 Arranging Charts and Graphs

Action

Using Drag and Drop

Using Context Menus

Using the Keyhoard

Move a graph to
create a new chart
in the same view

1. Shift-click the graph.

2. Drag the selected
graph to a border area
in the view.

3. Drop the graph to
create a new chart.

Shift-click the graph.
Right-click the selected
graph.

Select Cut graph.
Right-click anywhere in
the view.

Select Paste chart to
new chart.

1. Select the source graph.
2. Press Ctrl+X.
Press Ctrl+Shift+V.

Copy a graph to Not available Shift-click the graph. 1. Select the source graph.
.create. anew chart Right-click the selected 2. Press Ctrl+C.
ina different view graph. 3. Select the other view.
Select Copy graph. 4. Press Ctrl+Shift+V.
Select the other view.
Right-click anywhere in
the view.
Select Paste chart to
new chart.
Move a graph to Not available Shift-click the graph. 1. Select the source graph.
create a new Chan Right-click the selected 2. Press Ctrl+X.
ina different view graph. 3. Select the other view.
Select Cut graph. 4. Press CtrHShift+V.

Select the other view.

Right-click anywhere in
the view.

Select Paste chart to
new chart.

Starting and Stopping Data Collection for Charts in a

View

To start data collection for the charts in a view:

1. Select the Views tab.
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2. Click the name of the view you want to start. Alternatively, right-click the name of the view
and select Start. The view is displayed in the View panel, and data collection begins.

To stop data collection for the charts in a view:
1. Select the Views tab.

2. Right-click the name of the view you want to stop and select Stop.

To stop all data collection for all views, click the @ (Stop All Active Views) button in the
toolbar. (It is not necessary to first select the Views tab.)

Scrolling and Zooming the Data Displayed in a Chart

You can display or hide the scrollbar for a chart, as explained in “Turning a Chart Scrollbar On
and Off” on page 6-27. The scrollbar includes controls for scrolling through data in the chart and
for zooming in and out of the data in a chart.

The scrollbar and zoom controls are displayed below the chart, as shown in Figure 6-10.

Figure 6-10 Scrollbar for a Chart
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The scrollbar contains controls for scrolling through historical data and for zooming in and out
of a set of data to change the time span displayed in the chart. The controls are shown in
Table 6-2.

Table 6-2 Controls in the Scrollbar

Control Name Use
I Thumb Drag to scroll through historical data.
= | Left scroll arrow  Click to scroll backwards through historical data.
| = I Right scroll arrow  Click to scroll forwards through historical data.

To display or hide the scrollbar for a chart:
1. Right-click anywhere in the chart.

2. From the context menu, select Show Scrollbar to display the scrollbar or Hide Scrollbar to
hide it.

Scrolling Through Historical Data in a Chart

Under certain circumstances, described below, you can scroll back and forth through a chart’s
history, to see both historical and current data for the chart. Historical data is always retrieved
from an archive, which means that historical data is only available if you have configured WLDF
to gather metrics data (for metrics charts) and/or if you have configured WLDF to gather
instrumentation data (for method performance charts). For more information about how this is
handled, see Chapter 4, “Understanding How Data Is Collected and Presented.”

To scroll through historical data:

1. Make sure that WLDF was configured to collect the metrics or instrumentation data you want
to monitor.

2. Select the chart containing the data you want to monitor.
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3. Drag the scrollbar’s thumb control 1 to the interval you want to monitor. As you drag
the thumb control, a message is displayed that shows the beginning and end times of the
intervals you are scrolling through.

Alternatively, click —'Ip (left scroll arrow) to scroll backwards or click e (right scroll
arrow) to scroll forward. Clicking these buttons scrolls the viewport (the span displayed in
the chart) by 10% of the viewport width. Clicking directly on the scrollbar (not on the
thumb control) scrolls the viewport by 50% of the viewport width.

While you scroll, a message is displayed showing the time intervals you are scrolling through.
When you stop scrolling, the data is retrieved for the selected interval. To display the dates and
times for the visible interval, position the mouse pointer anywhere on the scrollbar.

If no archived data is available for a metrics graph, only the data available in the cache of actively
polled metrics can be displayed. If you scroll to a point earlier than the data available in the cache,
no data is displayed for that graph.

It can happen that you scroll back to view historical data that is not backed by the WLDF archive,
and then that data expires from the cache while it is still displayed in the chart. If that happens,
you will not be able to view that historical data again once you scroll away from it. To alert you
that the data points have expired, the chart behind those data points is darkened, and tooltips for
the chart and for the expired data points display messages to report that the data has expired. For
example, see Table 6-11.

Figure 6-11 Expired Data Points
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To display current data after scrolling:

1.

Select the chart.

2. Do one of the following:

— Move the thumb control all the way to the right on the scroll bar, or

— Right-click the chart, then select View Current Data from the context menu.

Zooming In and Out of Data in a Chart

You can zoom into the data shown in a chart to expand the view of data points for a shorter time

span, and you can zoom out to show details about a longer time span.

Zoom in and out as follows:

e To zoom in on the X-axis, right-click anywhere in the chart and select Zoom In (or press

Alt-z). You zoom in to a percentage displayed time interval. Set the percentage in the
Global Properties tab.

To zoom out of the X-axis, right-click anywhere in the chart and select Zoom Out (or
press Alt-o).

To zoom in on the X-axis by a custom interval, Shift-drag over an area of the chart. That
is, press and hold the Shift key, then drag the mouse pointer over the area of the chart you
want to display. (You must release the mouse button before you release the Shift key.)

To reset the interval to its state before it was zoomed, right-click the chart and select Zoom
Reset (R) from the context menu (or press Alt-r). Resetting the zoom state resets the
interval back to the default interval of five minutes, starting at the start time which was in
effect before zooming.

Deleting a Graph from a Chart

6-22

1.

To delete a graph from a chart:

Select the Views tab and select the view containing the chart containing the graph you want
to delete.

2. Select the graph in either of the following ways:

— Shift-click anywhere on the graph.
— Shift-click on the legend entry for the graph.
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3. Click the ¥ (Delete) button in the toolbar, or press the Delete key.

Note: If you discard changes to the view containing the deleted graph, you can recover it.
However, you cannot selectively discard changes, so you will lose any other changes
you made, too. Once you save changes to the view, the deleted graph is permanently
deleted and cannot be recovered.

Deleting a Chart

To delete a chart:
1. Select the Views tab and select the view containing the chart you want to delete.

2. Click the chart. A border appears around the chart to show it has been selected.

3. Click the ¥ (Delete) button in the toolbar, or press the Delete key.

Note: If you discard changes to the view containing the deleted chart, you can recover it.
However, you cannot selectively discard changes, so you will lose any other changes
you made, too. Once you save changes to the view, the deleted chart is permanently
deleted and cannot be recovered.

Setting Chart Properties

When you create a chart, it is created with default visual and control properties. To change those
properties:

1. Select the Views tab and select the view containing the chart whose properties you want to
change.

2. In the View panel, click anywhere in the chart to select it.

3. Select the Properties > Selected Item Properties tab to display controls for changing
properties.

4. Make changes by setting the properties in the Properties > Selected Item tab, as described
in the following sections:

— “Changing a Chart Name” on page 6-24

— “Creating a Y-Axis Label for a Chart” on page 6-25
— “Setting a Chart Graphing Style” on page 6-25

— “Turning a Chart Legend On and Off” on page 6-26
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5.

— “Turning a Chart Scrollbar On and Off” on page 6-27
— “Changing Chart Foreground and Background Colors” on page 6-27

Click the Apply Changes button to apply your changes to the selected chart.

Note: You can change some properties directly in the View panel. For example, you can
right-click a chart name or view name to display an edit field and then type a new
name in the field. In that case, you do not have to click Apply Changes. Just click
outside the text box to see your changes.

Alternatively, click Discard Changes to restore the settings that were in effect when you
started changing them, or click Restore Defaults to restore the WLDF Console Extension
default settings for charts.

Note: Applying a change to a property does not save it for future use. See step 6.

If this is a chart in a custom view, you can save the changes so they will be restored the next
time you open the WLDF Console Extension. (You cannot save changes to a chart in a built-in
view.) To save a custom chart, you must save the view, as follows:

a. Select the Views tab.
b. Click the Save button.

Alternatively, on the toolbar, click the =l (Save All Modified Views) button.

Note: You cannot save changes to the properties of a chart in a built-in view.

Changing a Chart Name

You can change the name of charts in built-in and custom views. But you can save the name only
for charts in custom views. To change the name of a chart:

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in
steps 1-3 in “Setting Chart Properties” on page 6-23.

2. Select the General subtab.

3. Enter a new name in the Name field.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart Properties”
on page 6-23.

Alternatively:

1. Display the view containing the chart.
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2. Right click the name at the top of the chart.
3. Type a new name in the field.
4. Click anywhere outside the field to apply the change.

5. Save the changes, as explained in step 6 of “Setting Chart Properties” on page 6-23.

Creating a Y-Axis Label for a Chart

No Y-Axis label is assigned by default for a chart, but you can create one, as follows:

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in
steps 1-3 in “Setting Chart Properties” on page 6-23.

2. Select the General subtab.
3. Inthe Y-Axis field, enter text to be used as the Y-Axis label.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart Properties”
on page 6-23.

Setting a Chart Graphing Style

By default, graphs are created using the “plot” style (dots connected by lines). However, you can
change the style, as follows:

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in
steps 1-3 in “Setting Chart Properties” on page 6-23.

2. Select the General subtab.

3. Select a style from the Style drop down list to change the visual style of each graph on the
selected chart. Styles include:

Tahle 6-3 Graph Styles

Style Example Description

Area i Solid area under a line
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Tahle 6-3 Graph Styles

Area radar Y Circular area, with new data sweeping
. clockwise, as with a radar
Bar i Bars alternating for each graph
Dhallln
Plot Sequential dots connected by lines
Scatter plot T Dots only
Stacking area Areas for each graph, stacked on top of each
NP other

Stacking bar

Bars for each graph, one stacked on top of the
other

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart Properties’

on page 6-23.

bl

Turning a Chart Legend On and Off

A chart’s legend identifies each graph on the chart. Each line in the legend shows the color and
graphic used to plot the data points and identifies the data source for the graph.

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in
steps 1-3 in “Setting Chart Properties” on page 6-23.

2. Select the General subtab.

3. Check the Legends checkbox to display the legend, or uncheck it to hide the legend.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart Properties’

on page 6-23.
Alternatively:

bl
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Display the view containing the chart.
Right-click anywhere in the chart.

From the context menu, select Hide Legend to turn the legend off, or select Show Legend to
turn the legend back on. (You can also press Alt-L to toggle the legend on and off.)

Turning a Chart Scrollbar On and Off

You can use the scrollbar to scroll back through historical data and the attached zoom controls to
zoom in and out of data, as explained in “Scrolling and Zooming the Data Displayed in a Chart”
on page 6-19. The scrollbar is hidden by default, however, you can display it and hide it again, as
follows:

1.

Select the chart and select the Properties > Selected Item Properties tab, as explained in step
1-3 in “Setting Chart Properties” on page 6-23.

Select the General subtab.

. Check the Scrollbar checkbox to display the scrollbar, or uncheck it to hide the scrollbar.

Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart Properties”
on page 6-23.

Alternatively:

1.
2.
3.

Display the view containing the chart.
Right-click anywhere in the chart.

From the context menu, select Hide Scrollbar to turn the scrollbar off, or select Show
Scrollbar to turn the scrollbar back on. (You can also press Alt-S to toggle the scrollbar on
and off.)

Changing Chart Foreground and Background Colors

The foreground color for a chart includes the color of the text used for the legend and the color
of the X- and Y-axis lines and values. The background color is the color used for the background
of the entire chart.

1.

Select the chart and select the Properties > Selected Item Properties tab, as explained in
steps 1-3 in “Setting Chart Properties” on page 6-23.
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2. Click the Colors > Foreground subtab to change the foreground colors, or click the Colors
> Background subtab to change the background colors.

3. Select your preferred color chooser, by clicking one of the subtabs: Swatches, HSB, or RGB.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart Properties”
on page 6-23.

Setting Individual Graph Properties

6-28

When you create a graph in a chart, it is created with default visual and control properties. To
change those properties:

1. Select the Views tab and select the view containing the chart with the graph whose properties
you want to change.

2. In the View panel, select the graph in either of the following ways:
— Shift-click anywhere on the graph.
— Shift-click on the legend entry for the graph.

3. Select the Properties > Selected Item Properties tab to display controls for changing graph
properties.

4. Make changes by setting the properties in the Properties > Selected Item tab, as described
in the following sections:

— “Changing a Graph Name” on page 6-29
— “Changing a Graph’s Colors” on page 6-29
5. Click the Apply Changes button to apply your changes to the selected chart.

Alternatively, click Discard Changes to restore the settings that were in effect when you
started changing them, or click Restore Defaults to restore the WLDF Console Extension
default settings for charts.

Note: Applying a change to a property doesn’t save it for future use. See step 6.

6. Ifthis graph is in a chart in a custom view, you can save the changes so they will be restored
the next time you open the WLDF Console Extension. (You cannot save changes to a chart in
a built-in view.) To save a custom chart, you must save the view, as follows:

a. Select the Views tab.

b. Click the Save button.
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Alternatively, on the toolbar, click the [—l (Save All Modified Views) button.

Note: You cannot save changes to the properties of a chart in a built-in view.

Changing a Graph Name

When you drag an item onto a chart to create a graph of the item’s data points, a name is assigned
by default. This name appears in the legend for the chart containing the graph. You can change
the name, as follows:

1.

Select the graph and select the Properties > Selected Item Properties tab, as explained in
steps 1-3 in “Setting Individual Graph Properties” on page 6-28.

Click the General subtab.
Enter a new name in the Name field.

Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Individual Graph
Properties” on page 6-28.

Changing a Graph Scaling Factor

Adjusting the scaling factor for a graph adjusts the units used for the Y-Axis. For example, if a

Y-Axis unit of 60,000 is scaled to 1, and you change the scaling factor to 10, the units are changed
to 600,000. Changing the scaling factor of a graph is useful when a chart contains more than one
graph, and you want to adjust the different graphs to be able to see them in relation to each other.

1.

Select the graph and select the Properties > Selected Item Properties tab, as explained in
steps 1-3 in “Setting Individual Graph Properties” on page 6-28.

Select the General subtab.

. Select a scaling factor from the Scale dropdown list.

Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Individual Graph
Properties” on page 6-28.

Changing a Graph’s Colors

The foreground color for a graph includes the color of the line and symbols used to plot data in
the graph, where appropriate. The background color is the fill color for the graph, where
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appropriate for the selected graph style. These colors are assigned by default, but you can change
them, as follows:

1.

3.

Select the graph and select the Properties > Selected Item Properties tab, as explained in
steps 1-3 in “Setting Individual Graph Properties” on page 6-28.

Click the Colors > Foreground subtab to change the foreground colors, or click the Colors
> Background subtab to change the background colors.

Select your preferred color chooser, by clicking one of the subtabs: Swatches, HSB, or RGB.

Setting Global Properties

Global properties apply to all active views. To set global properties, click the Properties tab, then
click the Global Properties subtab. You can set the following properties:

6-30

o Polled data set size. The number of dynamically gathered samples retained in the data
cache on the server for each monitored metric. For information about the data caches, see
Chapter 4, “Understanding How Data Is Collected and Presented.”

e Autoscroll Speed. If a view contains several charts, you may have to scroll the window to
see all the charts. If you drag an item from the Tabs panel towards an edge of such a view,
the window scrolls so you can add the item to the hidden part of the view. The Autoscroll
Speed setting sets the speed of the scrolling, in inches per second.

o Autoscroll Insets. The width of the region surrounding a panel that is used to trigger
automatic scrolling.

e Default Viewport Size. The default size of the chart viewport in minutes. You can change
the viewport size by zooming in or out.

e Zoom Percentage. The percentage by which the chart viewport size is changed during a
zoom in (Alt-z) or a zoom out (Alt-0) operation.
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Working with Metrics Charts and
Graphs

Metrics charts and graphs plot the values of MBean instances and attributes. The values can be
real-time polled metric values obtained from a running WebLogic Server, or they can provide a
historical view of that metric value for all metrics maintained by the WLDF Harvester.

To create charts and graphs based on metrics data, you drag metrics attributes from the Metrics
tab to the View panel. Each new graph shows the value of the selected attribute over time.

The following sections describe how to work with metrics charts and graphs:
e “Selecting a Server” on page 7-2
e “Understanding the Contents of the MBean Tree in the Metrics Tab” on page 7-2
e “Displaying Items in the Metrics tab” on page 7-2

e “Displaying Details About MBean Instances and Attributes in the Metrics Tab” on
page 7-3

e “Displaying Details About Metrics Charts and Graphs” on page 7-3

e “Creating Custom Metrics” on page 7-4

For general information about working with metrics charts and graphs and with method
performance charts and graphs, see Chapter 6, “Working with All Charts and Graphs.”

Using the WebLogic Diagnostic Framework Console Extension 1-1



Working with Metrics Charts and Graphs

Selecting a Server

The Metrics tab displays metrics available for a single server at a time. To select a different
server, select the server from the Server dropdown list. The Server dropdown list displays all the
servers in the domain.

Understanding the Contents of the MBean Tree in the
Metrics Tab

The Metrics tab displays a tree containing the following:
e WebLogic MBean types
o Currently registered instances of the WebLogic MBean types
e Currently registered instances of custom MBean types

e Attributes of the listed registered instances

The icons described in Table 7-1 help to identify items in the tree:.

Tahle 7-1 Visual Cues in the MBean Tree in the Metrics tah

Icon Represents...
WebLogic MBean type
63 JMX MBean type
s
@ Custom MBean type
i MBean instance
@ Attribute of an MBean instance

Displaying Items in the Metrics tab

The tree shows the MBean types, instances, and attributes for a server. Display items in the
Metrics tab, as follows:
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e To view the MBeans from a different server in the domain, select the server from the
Select server dropdown list. (You can display MBeans from only one server instance at a
time, but you can create a chart using data from more than one server.)

e To refresh the tree for the selected server, click the Reload button.

e To show all currently registered instances of a listed MBean type, click the  (Expand)
button to the left of the type name.

Note: If the MBean type has no registered instances, the name of the MBean type appears
in a gray, italic font. If no instances are registered, you cannot expand the node.

e To show all attributes of a listed MBean instance, click the # (Expand) button to the left of
the left of the MBean name.

Displaying Details About MBean Instances and Attributes
in the Metrics Tab

You can display details about MBean instances and attributes by placing the mouse pointer over
items in the tree of MBeans displayed in the Metrics tab:

e Point to an MBean instance name to display the full object name of the MBean instance.

e Point to an MBean attribute name to display the type and description of the attribute.

For more information about displaying these kinds of details, see “Displaying Tooltips for
Controls, Views, Graphs, and Charts.”

Displaying Details About Metrics Charts and Graphs

You can display details about metrics charts and graphs displayed in the View panel by pointing
the mouse pointer at objects in the panel:

e Point to a data point in a graph to display the time the data point was plotted and the
sampled metric value at that time.

e Point to a chart legend to display the object instance name for each attribute listed in the
legend.

e Point to a chart scrollbar to display the beginning data and time and the ending date and
time for the visible interval. This tooltip also tells if this interval is the current interval.
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For information about displaying these details, see “Displaying Tooltips for Controls, Views,
Graphs, and Charts.”

Creating Custom Metrics

You can track a metric based on an attribute of any registered MBean simply by dragging the
attribute to a chart. You can also create more complex custom metrics by performing a variety of
functions on one or more MBean instance attribute values. The custom metric is then available
for creating graphs for all instances of a type.

To create a custom metric:

1. In the Metrics tab, right-click the name of the MBean type for which you want to create a
custom metric.

2. From the context menu, select Create Custom Metric. The Custom Metric Editor is
displayed in the right panel, replacing any view displayed in the View panel.

Note: The Custom Metric Editor provides comprehensive help through tooltips. To display

a tooltip, point the mouse at a field, function, or item in an expression, then pause for
a moment until the tooltip is displayed.

3. Define a custom metric by constructing an expression in the Expression field of the Custom
Metric Editor, as follows:

To insert a function, drag the function from the Available Functions box and drop it
into the appropriate position in the Expression field. The available functions are
explained in Table 7-2, Table 7-3, and Table 7-4. The positions where you can drop an
item are described later in this step

To insert a simple metric based on an MBean attribute, drag the attribute (metric) from
the Metrics tab and drop it into the appropriate position in the Expression field. (You

can also drag a previously defined custom metric into the Expression field to create a

nested custom metric.)

To edit a scalar value in an expression, right click the value in the Expression field,
select Edit from the context menu, then enter a new value.

To delete an item from the expression in the Expression field, right-click the item, then
select Delete from the context menu.

The Custom Metric Editor enforces where you can drop a function or attribute. When you
drag an item to an allowed position in the Expression ficld, the position is highlighted to
indicate you can drop an item there. You can drop into the following positions:
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— Drag a metric or a function directly onto another metric or function to replace it.

Note: If no metric or function has yet been inserted where one is required, The
placeholder <Mp> (that is, a metric placeholder) appears wherever a metric or
function is required but none has yet been added. You can drag a function or
metric onto any occurrence of <Mp>.

— Drag a function onto an insert area to insert it into that position, without replacing any
existing items. Any terms to the right of the inserted function are included as the first
argument to the function.

Note: To display symbols that indicate where the insert areas are, check the Show
Insert Areas checkbox under the Expression field.

Click Save to save the metric or Cancel to close the Custom Metric Editor without saving the
metric.

Note: When you display the Custom Metric Editor for an MBean type, you can use the editor

to build an expression for that MBean type only. If you want to create a custom metric
for a different MBean type, you must save or cancel the expression you are building, then
right-click the different MBean type to create a custom metric for it.

Editing and Deleting Custom Metrics

To edit or delete a custom metric:

1.

In the Metrics tab, find the MBean type for which you defined the custom metric.

Click the ! icon next to the name of the MBean type to display its instances, if they are not
already displayed.

Click the *l icon of any MBean instance to display its metrics, if none are already displayed.
A custom metric defined for an MBean type is displayed for every MBean instance derived
from the type.

Right click the name of the custom metric.

Select Edit Custom Metric to edit it or Delete Custom Metric to delete it. When you edit a
custom metric, it is changed for every MBean instance of the type. When you delete a custom
metric from the list of metrics for an MBean instance, it is deleted from all the instances of
the type.
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Changing the Name of a Custom Metric

To create a copy of a custom metric:

1. Inthe Metrics tab, find the MBean type for which you defined the custom metric whose name
you want to change.

2. Right-click the name of the custom metric.
3. Select Edit Custom Metric.
4. In the Metric Name field, change the metric’s name.

5. Click Save.

Creating a Copy of a Custom Metric

To create a copy of a custom metric:

1. In the Metrics tab, find the MBean type for which you defined the custom metric you want
to copy.

2. Right-click the name of the custom metric.
3. Select Edit Custom Metric.
4. In the Metric Name field, change the metric’s name.

5. Click Save As.

Functions for Creating Custom Metrics

The Available Functions box in the Custom Metric Editor lists all the functions you can use to
construct an expression. To display a note about what each function does, point the mouse to the
function and pause. A tooltip is displayed. The functions are listed by type and explained in the
following tables:

e Table 7-2, “Functions Accepting Vector and/or Scalar Data but Not Requiring State from
Previous Data,” on page 7-7

e Table 7-3, “Functions Accepting Vector and/or Scalar Data and Requiring State from
Previous Data,” on page 7-8

e Table 7-4, “Functions that Operate Over an Interval,” on page 7-8.
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Note: In the tables, <MP> represents a function or a defined metric.

Table 7-2 describes functions that accept vector and/or scalar data but do not require a computed
state from previous data for comparing results.

Table 7-2 Functions Accepting Vector and/or Scalar Data but Not Requiring State from Previous Data

Function Description
Abs (<MP>) Absolute value of the argument
Change (<MP>) Difference between the current value and the last observed

value of the argument

Difference (<MP>, <MP>) Difference of the observed values of the arguments, for
example, A1-A2.

Difference (<MP>,NumericValue) Value determined by subtracting the provided scalar value
from the current value

Inverse (<MP>) Inverse of the observed value of the argument, for example
(1/value)

Negative (<MP>) Negative of the observed value of the argument, that is,
0-value

Over (<MP>, Threshold) Boolean value (0 or 1) indicating when the value of the

first argument falls below the provided constant threshold

Product (<MP>, <MP>) Multiple of the observed values of the arguments, for
example, A1*A2

Product (<MP, NumericValue>) Value determined by multiplying the current value by the
provided scalar value

Ratio (<MP>, NumericValue) Ratio of the observed values of the arguments, for example,
Al/A2
Ratio (<MP, <MP>>) Value determined by multiplying the current value by the

provided scalar value

Sum (<MP>, <MP>) Sum of the observed values of the arguments, for example,
Al+A2
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Tahle 7-2 Functions Accepting Vector and/or Scalar Data but Not Requiring State from Previous Data

Function Description

Sum (<MP>, NumericValue) Value determined by adding the provider scalar to the
current value

Under (<MP>, Threshold) Boolean value (0 or 1) indicating when the value of the
first argument falls below the provided constant threshold

Table 7-3 describes functions that accept vector and/or scalar data and that do require a computed
state from previous data for computing results.

Table 7-3 Functions Accepting Vector and/or Scalar Data and Requiring State from Previous Data

Function Description

Count (<MP>) Number of observed values of the argument

Max (<MP>) Maximum observed value of the argument

Mean (<MP>) Mean of the observed values of the argument

Min (<MP>) Minimum observed value of the argument
StandardDeviation (<MP>) Standard deviation of the observed values of the argument
Summation (<MP>) Sum of all the observed values of the argument

Table 7-4 describes functions that operate over an interval.

Table 7-4 Functions that Operate Over an Interval

Function Description

Change (<MP>, Interval) Difference between the current value and the first value at
a time greater than or equal to the time T-I where T is the
millisecond interval value provided

HighModel (<MP>, Interval) Median of the observed values of the argument over the
interval defined by the provided value
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Table 7-4 Functions that Operate Over an Interval

Function Description

LowModel (<MP>, Interval) Median of the observed values of the argument over the
interval defined by the provided value

Median (<MP>, Interval) Median of the observed values of the argument over the
interval defined by the provided value
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CHAPTERa

Working with Method Performance
Charts and Graphs

Method performance charts and graphs plot method performance information that is based upon
the real-time and historical views of method performance that can be captured through the WLDF
instrumentation capabilities.

The following sections describe how to work with method performance charts and graphs:

“Making Instrumentation Data Available for Method Performance Charts” on page 8-2
“Selecting a Server” on page 8-2

“Creating Method Performance Charts and Graphs” on page 8-3

“Displaying Requests and Methods in the Requests Tab” on page 8-3

“Displaying Details About Requests” on page 8-4

“Displaying Details About Instrumentation Events” on page 8-5

“Displaying Details about Requests and Methods in the Requests Tab” on page 8-7
“Selecting a Time Interval for Obtaining Request Data” on page 8-8

“Displaying Details About Method Performance Charts” on page 8-8

For general information about working with metrics charts and graphs and with method
performance charts and graphs, see Chapter 6, “Working with All Charts and Graphs.”
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Making Instrumentation Data Available for Method
Performance Charts

You must configure WLDF instrumentation outside of the WLDF Console Extension to make
instrumentation data available for creating method performance charts and graphs. The following
criteria must be met:

e A WLDF system resource must be created and targeted to the server. Create the system
resource by creating a weblogic-diagnostics.xml descriptor. You can do that using the
WebLogic Server Administration Console, using the WebLogic Scripting Tool (WLST), or
by creating it directly in an editor.

e Instrumentation in the targeted WLDF system resource must be enabled.

e Application instrumentation must be enabled with a
META-INF/weblogic-diagnostics.xml descriptor in the application

e Application instrumentation descriptors must use TraceElapsedTimeAction diagnostic
actions attached to "Around" type diagnostic monitors. For example, a descriptor could
contain the following:
<instrumentation>

<enabled>true</enabled>
<wldf-instrumentation-monitor>
<name>Connector Around Inbound</name>
<action>TraceElapsedTimeAction</action>
</wldf-instrumentation-monitor>
</instrumentation>
See “Diagnostic Monitor Library” in Configuring and Using the WebLogic Diagnostic
Framework for a list of “Around” type monitors.

See”Configuring Instrumentation” in Configuring and Using the WebLogic Diagnostic
Framework for more information about how to accomplish these tasks outside of the WLDF
Console Extension.

If instrumentation is not configured and enabled for the selected server, no data will appear in the
WLDF Console Extension Requests tab.

Selecting a Server

The Requests tab displays instrumented methods available for a single server at a time. To select
a different server, select the server from the Server dropdown list. The Server dropdown list
displays all the servers in the domain.
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Creating Method Performance Charts and Graphs

Creating Method Performance Charts and Graphs

To create and modify charts and graphs based on instrumented methods, you drag methods from
the Requests tab to the View panel to create or modify a method performance chart. Each graph
shows the elapsed invocation times of the selected method over time.

Figure 8-1 Requests Tree and a Method Performance Chart
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Displaying Requests and Methods in the Requests Tab

The Requests tab shows information about requests that flow through instrumented code. When
such requests execute instrumented methods, instrumentation events are generated at the start and
end of the methods.

The Requests tab includes a tree of method calls for identified requests. At the top level, the tree
shows all identified requests from the specified server within a specified interval, as shown in
Figure 8-2.
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Figure 8-2 Requests Listed in the Requests Tah

Requests
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- — 0000000000000019 [MedrecEAR] org. apache. skruks, taglib. html, Herl Tag doStartTag *

Requests are identified by:
e A unique request ID
e The name of the application
e Information about the top level method executed by the request

e The execution time of the request is shown by a horizontal bar, whose length is
proportional to the relative weight of the node with respect to all its siblings at the same
level in the method invocation tree.

Expanding a request node shows its top level instrumented method, as shown in Figure 8-3.
Within the call tree, if a method calls other instrumented methods, they are shown as its children.
A method node in the call tree shows the instrumented class and method name.

Figure 8-3 Expanded Request Node in the Requests Tah

Requests
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Displaying Details About Requests

To display details about a request listed in the Requests tree, click the string that identifies the

request (not the = (Expand) or = (Collapse) buttons). The information is displayed in the
panel below the tree, as shown in Figure 8-4.
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Displaying Details About Instrumentation Events
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The attributes listed in this panel are described in Table 8-1.

Tahle 8-1 Request Values Displayed in Request Panel

Attribute Description

Class Name A Java class containing a method that handled this request.
Method The method that handled this request.

Count The number of times this method handled this request.

Total Time (ms)

The total time taken by this method to handle this request, in
milliseconds.

Average Time (ms)

The average time taken by this method to handle this request, in
milliseconds.

Scope The scope of the class containing the instrumented code.
Module The application module containing this class.
Signature The signature of the method.

Displaying Details About Instrumentation Events

To display details about the instrumentation event associated with a method invocation, click the
method invocation node. The information is displayed in the panel below the call tree, as shown

in Table 8-2.
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Figure 8-5 Details About an Event
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The attributes listed in this panel are described in Table 8-2.

Tahle 8-2 Event Values Displayed in Request Panel

Attribute Description

Record ID Unique identifier to identify this record in the log.

Timestamp Date when this event was generated.

Context ID Diagnostic context information to correlate messages coming from a

specific request or application.

Transaction ID The identifier for the transaction that initiated this diagnostic event.
Present only for messages logged in the context of a transaction.

User The user ID under which this diagnostic event was executed.

Type Type of diagnostic action triggered by this diagnostic event.

Domain Domain in which this event was generated.

Server The name of the WebLogic Server instance on which this event was
generated.

Scope Server or application scope in which this diagnostic event was
generated.

Module Diagnostic module through which this diagnostic event was
generated.
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Tahle 8-2 Event Values Displayed in Request Panel

Attribute Description
Monitor Diagnostic monitor that triggered this diagnostic event.
File Name Name of the Java file containing the instrumented method that

generated this diagnostic event.

Line Number Line in the source file where instrumented code exists.

Class Name Name of the Java class containing the instrumented method.

Method Name Name of the instrumented method that generated this diagnostic
event.

Method signature The signature of the method that generated this diagnostic event.

Payload The payload.

Context Payload The diagnostic context payload associated with diagnostic event.

Dyes The diagnostic dyes associated with the method that initiated this
event.

Displaying Details about Requests and Methods in the
Requests Tab

You can display details about the requests and method calls by placing the mouse pointer over
items in the tree of requests and methods displayed in the Requests tab:

e Point to a request node to display the request ID, request start time, and request elapsed
time.

e Point to a method invocation node to display the method elapsed time, percentage with
respect to the parent method, and application name.

For more information about displaying these kinds of details, see “Displaying Tooltips for
Controls, Views, Graphs, and Charts.”
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Working with Method Performance Charts and Graphs

Selecting a Time Interval for Obtaining Request Data

You can create a graph based on events executed during a specified time interval, as described in
the following table:

To specify a predefined From the Interval drop down list, select one of the following:
interval that ends in the + Last 5 minutes to display events data for the previous five minutes
present + Last 15 minutes to display events data for the previous fifteen
minutes
* Last 30 minutes to display events data for the previous 30 minutes
» Last 1 hour to display events data for the previous hour
To specify a custom 1. From the Interval drop down list, select Last dd hh mm. The
interval that ends in the Duration (DD HH MM) text entry field appears.
present 2. Enter a value for the interval, in the format DD HH MM, where
- DD is the number of previous days
- HH is the number of previous hours
- MM is the number of previous hours
To specify a custom 1. From the Interval drop down list, select Custom. A set of fields for
interval that may not end in entering the duration appears.
the present: 2. Click the Start drop down control to display a calendar. Select a start

date.

3. Specify a starting hour and minute by replacing HH MM in the text
entry box with the starting hour and minutes.

4. Enter a duration by replacing DD HH MM in the Duration text entry
box with the desired days, hours, and minutes.

Displaying Details About Method Performance Charts

You can display details about method performance charts and graphs displayed in the View
panel:

e Point to a data point in a graph to display the time the data point was plotted and its value
when it was plotted, in nanoseconds.

e Point to a chart’s scroll bar to display the beginning date and time and ending date and
time for the visible interval. This tooltip also reports if the interval is the current interval.

e Point to a chart’s legend to display the following for each entry in the legend:
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Displaying Details About Method Performance Charts

— Class name containing the instrumented method
— Scope of the instrumented method
— Signature of the instrumented method

For information about displaying these details, see “Displaying Tooltips for Controls, Views,
Graphs, and Charts.”
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Working with Method Performance Charts and Graphs
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Keyboard Reference

Most of the WLDF Console Extension documentation tells how to accomplish tasks using the
mouse. However, you can accomplish virtually all of those tasks using the keyboard only, as
described in the following sections:

e “Terms and Conventions” on page A-1
e “Navigating and Selecting” on page A-2

e “Keyboard Reference” on page A-2

Terms and Conventions

The following terms and conventions are used in Table A-1:

e Controls are items such as buttons, tabs, text fields, and sliders that you use to perform
actions or view information. In some circumstances, a control may be disabled, which
means that it is not available in the current context. For example, if no views have unsaved
changes, the button for saving all views is disabled, and you are unable to select it using
the keyboard. In that case, the appearance of the button is changed; for example it may be
all gray, depending on the platform.

e Two key names separated by a + (plus sign), for example Shift+Tab, indicates that you
must hold down the first key, then press the second named key, then release both keys.
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Keyboard Reference

Navigating and Selecting

You can use the keyboard to navigate through the WLDF Console Extension, for example, press
the Tab key to move from one control to the other. However, navigating to a control does not
initiate an action with the control; it simply makes it available for receiving the next keyboard
input. For example, you can press Tab to navigate to a button but you must then press Enter to
press the button. In most cases, this is straightforward, and you do not have to be aware of the
distinction. A visual cue indicates that an item is selected. For example, a chart is surrounded by
a box, or the data points and (legend entry icon) in a scatter plot graph may be displayed as stars.
(The visual cues may be different on different platforms.)

The WLDF Console Extension has two main panels, the Tabs panel and the View panel, and one
of those tabs is always active. Keyboard input affects whatever control is selected in the active
panel. For example, if an edit field is selected in the active panel, any characters you type on the
keyboard are added to that edit field.

Certain actions affect the selected item in the panel that is not active. For example, you can
navigate to a chart in the View panel and select the chart. You can then navigate to the Selected
Item Properties tab in the Tabs panel and make a change to a property (that is, select the control
that sets the property’s value, change the value, navigate to the Apply Changes button, and press
Enter to push the button). When you apply the changes, the property is changed in the chart
selected in the (non-active) View tab.

gy
The =k (Focus Context) button on the toolbar indicates which panel is active. When the arrow
on the button points left, the Tabs panel (on the left) is active. When it points right, the View
panel (on the right) is active.

Keyboard Reference

A-2

Table A-1 describes how to use the keyboard to accomplish tasks in the WLDF Console
Extension.
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Keyboard Reference

Table A-1 WLDF Console Extension Keyhoard Access

Pressing this key  When this item is Does this...

or these keys... selected...

Enter Any button Presses the button.

Tab Tabs panel Selects the next active control. Repeatedly pressing the
(the panel on the left Tab key cycles through all active controls in the toolbar
side of the page) and the current tab. (That is, one control after another is

selected, while the previously selected control is
deselected. After the last control is selected, pressing
the Tab key again starts the process again.)

Shift+Tab Tabs panel Same as Tab, above, but selects the previous instead of

the next active control.

Tab View panel Selects the next chart in the view. Repeatedly pressing
(the panel on the right the Tab key cycles through all the charts.
side of the page)

Shift+Tab View panel Same as Tab, above, but selects the previous instead of

the next chart.
— Toolbar Selects the next active button in the toolbar. Repeatedly
) pressing the arrows cycles through the active buttons in
(Right arrow) the toolbar.
< Toolbar

(Left arrow)

Same as =, above, but selects the previous instead of
the next button.

— Tab controls (labels) in  Selects the next tab. Repeatedly pressing the arrows
(Right arrow) the Tabs panel cycles through all tabs.
< Tab controls (labels) in

(Left arrow)

the Tabs panel

Same as =, above, but selects the previous instead of
the next tab.

1

(Down arrow)

Tree of view names in
the Views tab

Selects the next view or folder.
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Keyboard Reference

Tahle A-1 WLDF Console Extension Keyhoard Access

Pressing this key  When this item is Does this...
or these keys... selected...
1 Tree of view names in Selects the previous view or folder.
the Views tab
(Up arrow)
Shift+—>* View panel Selects the next chart in the current view. Repeatedly
(Right arrow) pressing the Shift+—* cycles through all the charts in

the view.

Note: Ifthe Tabs panel is active when you click
Shift+ —*, the View panel becomes active,
and the next chart is selected.

Shift+4 View panel Same as Shift+=> above, but selects the previous

(Left arrow) instead of the next chart.

Shift- l View panel Selects the next graph in the current chart, or if there are
no more graphs in the chart, selects the first graph in the

Down arrow
( ) next chart. Repeatedly pressing Shift+ \ cycles

through all the graphs in all the charts in the view.

Note: Ifthe Tabs panel has is active when you click

Shift+ s , the View panel becomes active, and
the next graph is selected.

Shift +T View panel Same as Shift+%— | above, but selects the previous
instead of the next graph.
(Up arrow)
1 View panel Scrolls the contents of the panel up, if they extend

beyond the visible area.
(Down arrow)

1 View panel Scrolls the contents of the panel down, if they extend
beyond the visible area.
(Up arrow)
— Slider control Moves the slider control to the right.
(Right arrow)
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Keyboard Reference

Tahle A-1 WLDF Console Extension Keyhoard Access

Pressing this key ~ When this item is Does this...
or these keys... selected...
i Slider control Moves the slider control to the left.

(Left arrow)

Space bar Check box Selects or deselects the check box.

r Chart in the View panel. Displays current data in the selected chart. You can use
this to return to showing current data after viewing
historical data.

CtrI+X Chart or graph in the Cuts the selected chart or graph and places it onto the
View panel. Clipboard so it can be pasted to a new location.

Ctrl+C Chart or graph in the Copies the selected chart or graph onto the Clipboard so
View panel. it can be pasted to a new location.

Ctrl+V Chart in the View panel. Pastes the most recently cut or copied graph or chart

into the selected chart. If a graph was cut or copied, it
is added to the chart. If a chart was cut or copied, it is
merged with the selected chart.

Note: You can paste a graph or chart into a different
view than the one containing the source graph
or chart.

Ctrl+Shift+V View in the View panel. Creates a new chart, based on the most recently cut or
copied graph or chart. If a graph was cut or copied, a
new chart containing that graph is created. If a chart
was cut or copied, a duplicate of the source chart is
created.

Note: You can paste a graph or chart into a different
view than the one containing the source graph
or chart.

Esc Anywhere Deselects the currently selected item(s).

If an in-place edit field is selected (for example, you
can right-click the name of the view or of a chart in the
View panel to edit it), pressing Esc first deselects the
edit field. Pressing Esc again deselects the chart.

Del Anywhere Deletes the currently selected item.
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